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,Ã�Ü,Ã�Ü,Ã�Ü,Ã�Ü  1.�������� P­4|P­4|P­4|P­4| �•2÷�•2÷�•2÷�•2÷   
 
1. �£  RefWorks �º�L�ä�| E°�:P­4|�•2÷�x  EÞEÞEÞEÞ

�¾�¾�¾�¾ Search�|&Ž�Ð�|&Ž�Ð�|&Ž�Ð�|&Ž�Ð Advance�y�y�y�y   
2. �T*ý  Descriptor�x�x�x�x	®	®	®	®A¢�yA¢�yA¢�yA¢�y�,!Š 
a
a
a
a  Pub Year

�x�Ï(��I�Ò�y�x�Ï(��I�Ò�y�x�Ï(��I�Ò�y�x�Ï(��I�Ò�y  �,!Š�Y�Ï�Ø�é �•2÷�" "½�ä�Š   
	®A¢�,!Š�x Descriptor�y*ý�c �•2÷�ã���º�S
,Y��AÂ2“.C	�G" ,Y�\)� �"5á�K�«�,!Š �î�¥
�p�Z5C,Y4¨�q�x�`�W  �•2÷ art�|	Ä�l��
part�! smart 1��y   

3. EÞ�¾(N�o�\�Ë��E°>! �•2÷�"  
4. 	*�Ð  Search�a�å�•�a�å�•�a�å�•�a�å�• 2÷2÷2÷2÷�"  
5. �l���•2÷ 4¨�q�"  
�
,Ã�Ü,Ã�Ü,Ã�Ü,Ã�Ü  2.�������� �T*ý�T*ý�T*ý�T*ý �º�S�t6Ò�x�º�S�t6Ò�x�º�S�t6Ò�x�º�S�t6Ò�x Lookup�y�y�y�y  
 
1. EÞ�¾ Search�|&Ž�Ð�|&Ž�Ð�|&Ž�Ð�|&Ž�Ð Lookup by Descriptor�|�<�|�<�|�<�|�<

>!>!>!>!�Þ�Þ�Þ�Þ	®	®	®	®A¢A¢A¢A¢�º�º�º�º�S�S�S�S�y�y�y�y�"   
2. �S���Õ�ÿ �º�Þ�ï�6A…�*,Y	®A¢�"  
3. &Ž�Ð	®A¢�|��/� Aº	®A¢�à,Y���ÞA…�*�"  
 
"½�ä�Š�}	Ä�º4ëEf�ë�õL9 �º�S ��,Y �¥�ÿ ��AÂ�x�1
5Ú�!	®A¢�ë�ô�ß 	â�º�S �y�"E® ���/ 	¿�ï�ÎAº��AÂ
E°>!4ëEf�ë�õL9 �|5á�â �ï�F
¢�� 	—5Ø�\)� A…�*�"  
,Ã�Ü,Ã�Ü,Ã�Ü,Ã�Ü  3.�������� �ð�Ï�o��?›�Ó�ð�Ï�o��?›�Ó�ð�Ï�o��?›�Ó�ð�Ï�o��?›�Ó   
 
4. �£�º�L�äEÞ�¾  Tools�|&Ž�Ð Customize�Õ�Õ�Õ�Õ

� �o��� �o��� �o��� �o�� �"  
5. �ý “Output Style Choices for Reference 

View” �x	—5Ø�\)�Eh�Ï���äEÞ�¾�y�x	—5Ø�\)�Eh�Ï���äEÞ�¾�y�x	—5Ø�\)�Eh�Ï���äEÞ�¾�y�x	—5Ø�\)�Eh�Ï���äEÞ�¾�y 	ã,Y	ã,Y	ã,Y	ã,Y 1��Õ �ÿ
EÞ�¾�����|�(�Õ �à�ž9±	*�|EÞ�¾  AMA – 
American Medical Association 10th Edition�"  

6. 	*�ÐNJM7�jF½,Y Save�ÞJƒ�²�-�²�-�²�-�²�- �"  
7. �£�º�L�äEÞ�¾  “View” �x�º,à�y�|�x�º,à�y�|�x�º,à�y�|�x�º,à�y�| &Ž�Ð&Ž�Ð&Ž�Ð&Ž�Ð”All 

References”�|�º,à�|�º,à�|�º,à�|�º,à ���Þ	—5Ø�\)����Þ	—5Ø�\)����Þ	—5Ø�\)����Þ	—5Ø�\)� �"   
8. �£  “Switch to” �x�Ü�7�y�x�Ü�7�y�x�Ü�7�y�x�Ü�7�y �à�ž9±	*��EÞ�¾  

AMA ���ä�"  
9. 	—5Ø�\)��Û�ÞEÞ�o,Y���äE°>!��/�  - �T�}6Ò

�ôNY?•�¥/¢ 	—5Ø�\)� ,Y���ä �"  
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,Ã�Ü,Ã�Ü,Ã�Ü,Ã�Ü  4.�������� 	—5Ø�\)�	—5Ø�\)�	—5Ø�\)�	—5Ø�\)�  �g�d
a�(	E�g�d
a�(	E�g�d
a�(	E�g�d
a�(	E  
 
1. �²�Ö	—5Ø�\)���/��ý  AMA 10th ?›�Ó���|&Ž�Ð  “Sort By” �à�ž9±	*

�KEÞ�¾ “Title �|�|�|�| Primary” �"   
2. �ý�…,Y��/� �ì>=���|&Ž�Ð �"M7�°�6A…�* �»�|,Y�âEÞ�� �|EÞ���°�6

A…�*�"   

3. &Ž�Ð “ Print” �ÞJƒ�"   
4. �ý�…,Y0l	¸���|�£  “Favorites” �ì>=��EÞ�¾  

“Output Style” �|'�	ã&Ž�Ð  Print �"  
5. 	—5Ø�;,Ã�Þ�ß�Õ!:Py���}�� EÞ�o,YEh�Ï���ä

E°>!�(	E �|�K �º��Nm	â ,Y�,!¢NO�d�x Title �|�|�|�|
Primary �y�r ö �g�d�x?[,« �[	t Eh�Ï��
�ä�y�"  

6. �b ö&Ž�Ð “Print”  �(	E�\�Ë �|�ëEïEœ File�|�|�|�|
Save As4®�\�Ë
R	â�K�²�-��Av1l��4®�\�Ë
R	â�K�²�-��Av1l��4®�\�Ë
R	â�K�²�-��Av1l��4®�\�Ë
R	â�K�²�-��Av1l�� �"  

 
 
 
 
,Ã�Ü,Ã�Ü,Ã�Ü,Ã�Ü 5.�������� 4ëEf�ï�ÿ	—5Ø�\)�4ëEf�ï�ÿ	—5Ø�\)�4ëEf�ï�ÿ	—5Ø�\)�4ëEf�ï�ÿ	—5Ø�\)�  
 
"½�ä�Š�ý!9 �æ�Á�Û�a�å �Ñ�:	—5Ø�\)� �KE°>!4ëEf�" �}	Ä�ý4˜�5�a�å	ã�õL9E®�p	—5Ø�\
)��"  
 
1. EÞ�¾ “Search �|�|�|�| Online Catalog or Database”�x�x�x�x�•2÷�•2÷�•2÷�•2÷ �ý4”�ý4”�ý4”�ý4” �;�;�;�;,Ã�ë�E�C�h�y,Ã�ë�E�C�h�y,Ã�ë�E�C�h�y,Ã�ë�E�C�h�y  �|�ý  

RefWorks��E°>! �•2÷�"  
2. EÞ�¾ PubMed �1���ý4”�E�C�hE°>! �•2÷�"�"�"�"  
3. �ý  “Quick Search” �x�ÀEô�x�ÀEô�x�ÀEô�x�ÀEô �•�•�•�•2÷�y2÷�y2÷�y2÷�y  ���Z�|Eh�:  Influenza�|�|�|�|  '�	ã&Ž�Ð   “Search” �ÞJƒ�<

>!�•2÷ �"   
4. �ý4¨�q��/�0l	¸���|EÞ�¾�"�°�6A…

�*�|'�	ã&Ž�Ð  “Import” �ÞJƒ�a�å�Ñ
�:�"    

5. �ý�Ñ�:4¨�q��/�NJM7���|&Ž�Ð  “View 
Last Imported Folder” �ÞJƒ�º,à�ÕE¦�º,à�ÕE¦�º,à�ÕE¦�º,à�ÕE¦
�Ñ�:�Ñ�:�Ñ�:�Ñ�: ,YA…�*,YA…�*,YA…�*,YA…�*�"  

6. �b öEÞ�¾�°�6	—5Ø�\)��|'�	ã &Ž�Ð 
“Global Edit” �x�=��4ëEf�y�x�=��4ëEf�y�x�=��4ëEf�y�x�=��4ëEf�y  �ÞJƒ�"   

7. �ý  Add�x#Ð�u�y�x#Ð�u�y�x#Ð�u�y�x#Ð�u�y  	�
´�| �(�Õ  Specific Field
�x�x�x�x  �Ü�Ü�Ü�Ü�o�,!Š�y�o�,!Š�y�o�,!Š�y�o�,!Š�y  �à�ž9±	*���|EÞ�¾  
Descriptors�x	®EÅA¢�y�x	®EÅA¢�y�x	®EÅA¢�y�x	®EÅA¢�y �"  

8. �ý  “Descriptors�x	®EÅA¢�y�x	®EÅA¢�y�x	®EÅA¢�y�x	®EÅA¢�y” �\������Eh
�:  Vaccine'�	ã&Ž�Ð  OK �ÞJƒ.C�o.C�o.C�o.C�o �"     

9. �Û  “If Field Already Contains Data” �x�W�x�W�x�W�x�W
�q�,!Š�Ç4¤�Ú
��E�C�y�q�,!Š�Ç4¤�Ú
��E�C�y�q�,!Š�Ç4¤�Ú
��E�C�y�q�,!Š�Ç4¤�Ú
��E�C�y  EÞNNA“5C�� 
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Append to Existing Data�xEÒ�u��)…�Þ�E�C�y�xEÒ�u��)…�Þ�E�C�y�xEÒ�u��)…�Þ�E�C�y�xEÒ�u��)…�Þ�E�C�y  �"	®A¢  Vaccine �Û>€#Ð�u7È���ÞA…�*�|
�é���Þ 	t�Þ,Y	®A¢�²�Ö�â	­�"   
"½�ä�Š"½�ä�Š"½�ä�Š"½�ä�ŠOverwrite Existing Data�x?[,«)…�Þ�E�C�y�x?[,«)…�Þ�E�C�y�x?[,«)…�Þ�E�C�y�x?[,«)…�Þ�E�C�y  EÞNN�Û#ÚL9���ÞA…�*��,Y)…�Þ�¶�D
�x���`����	®A¢�,!Š�y�|�K*ý�}��#Ð�u,Y�E�CE°>!�Ô�7�" Leave Existing Data Alone
�x�â1v)…�Þ�E�C�y�x�â1v)…�Þ�E�C�y�x�â1v)…�Þ�E�C�y�x�â1v)…�Þ�E�C�y  EÞNN�š�Û���}#Ð�u7È(N�o�,!Š�x	H0O,R�,!Š�y��"v�Þ�Ð�*�¶�D,Y
4•�*�"Aº�t6Ò�ÛCÈEœ�,!Š���Ç4¤�Þ�¶�D,Y4•�*�"  
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10. �ý	®A¢�º �S���º,à4¨�q �"�x Search, Lookup By Descriptor �"�ý	®EÅA¢�º �SNJM7NKF½
,Y�,!¢�ì>=��&Ž�Ð  V �y�"  

 
,Ã�Ü,Ã�Ü,Ã�Ü,Ã�Ü 6.�������� My List �x�æ,Y�ì>=�y�x�æ,Y�ì>=�y�x�æ,Y�ì>=�y�x�æ,Y�ì>=�y  
 
1. �£�Ð�*�\�Ë�� �x Folder�y���|EÞ�¾ �"�ù�6	—5Ø�\

)��"   
2. &Ž�Ð Add to My List �x�…�s���æ,Y�ì>=�y�x�…�s���æ,Y�ì>=�y�x�…�s���æ,Y�ì>=�y�x�…�s���æ,Y�ì>=�y  �"  
3. '�	ã�|�ý  RefWorks �E�C�h���T*ý�Ð�*��AÂE°>! �À�À�À�À
EôEôEôEô�•�•�•�•2÷�x2÷�x2÷�x2÷�xQuick Search�y�y�y�y  �|'�	ã�£ �•2÷4¨�q��EÞ�¾�ù
�6A…�*�K�Û�K#Ð�u7È My List �x�æ,Y�ì>=�y�x�æ,Y�ì>=�y�x�æ,Y�ì>=�y�x�æ,Y�ì>=�y �"  
4. EïEœEÞ�¾ View �|�|�|�|  My List  �º,à�æ,Y�ì>=��,Y A…�*
�"  
 
"½�ä�Š"½�ä�Š"½�ä�Š"½�ä�ŠMy List�x�æ,Y�ì>=�y���Õ�ÿ�	�Ë�\�Ë�� �"�(�},P�Ï  RefWorks �å��	ã�| My List
�x�æ,Y�ì>=�y��,Y���Þ	—5Ø�\)��Û�7�â�X�Á�ý�},YBû����,Y	t� �"5C�"  
�
�
�
�
,Ã�Ü 7.�� �T*ý�T*ý�T*ý�T*ý  RefGrab-It �*9Œ5&NJ�*9Œ5&NJ�*9Œ5&NJ�*9Œ5&NJ 
 
1. �ý�º�L�ä���S���ý�º�L�ä���S���ý�º�L�ä���S���ý�º�L�ä���S�� Tools�|EÞ�¾�|EÞ�¾�|EÞ�¾�|EÞ�¾ RefGrab-It �|

�ý#$?•�=,Y�;1S�ë��;¤���"5C�^>š  RefGrab-It 
�§�Ë�"�W�q�},Y#$?•�=�Ç4¤�^>š  RefGrab-It�|
�îCÈ7È!:Py 3�"  

2. FJ'<NJM7�ß,YAÉ�ã�^>š�^>š�^>š�^>š  RefGrab-It�"   
3. �(�Õ	»�Õ�ÿ 5&NJ#$?•�=�|�K#$?• 5&NJ�Š  
http://en.wikipedia.org/wiki/Jane_Austen  
4. �£#$?•�=,Y Links �xJÓ�z�y�xJÓ�z�y�xJÓ�z�y�xJÓ�z�y �"5C	*�Ð  the 
RefGrab-It  JÓ�z�|�ë�£  Bookmarks�x�;1S�y�x�;1S�y�x�;1S�y�x�;1S�y �ë  Favorites�x���x���x���x��
;¤���y;¤���y;¤���y;¤���y �ì>=��E°>!EÞ�¾�"   
5. RefGrab-It �ý	»�Õ�ÿ0l	¸����/�4¨�q�"&Ž�Ð  Import �x�Ñ�:�x�Ñ�:�x�Ñ�:�x�Ñ�:
�y�y�y�y  �ÞJƒ�£  Wikipedia�x4É
Ï,S/¦�yNJM7�ß�Ñ�:�E�C�"�}�ÛE°�:  
RefWorks�"  
6. E©�³��/�  RefGrab-It 4¨�q,Y#$?•�=0l	¸�|'�	ã&Ž�Ð  Other Info �x�K�x�K�x�K�x�K
�«�¶�D�y�«�¶�D�y�«�¶�D�y�«�¶�D�y  �Ü1S�|�º,à  RefWorks �Ç4¤�º�S��,Y>:���¶�D
�"  
7. &Ž�Ð Other Info�x�K�«�¶�D�yNJM7��/�,Y  “DOI” 
a  
“Books” JÓ�z�|�º,à	Ä�pEÞ�¾�Ñ�:,Y�K�«	—5Ø�\)��"    
8. EÞ�¾EÞ�¾EÞ�¾EÞ�¾  “Books” �Ü1S�à�ì �Ï,Y�"�ù���Ó�;�"  
9. &Ž�Ð “Import” �x�Ñ�:�y�x�Ñ�:�y�x�Ñ�:�y�x�Ñ�:�y  �ÞJƒ�|�Û�K#Ð�u7È�},Y  
RefWorks Bû���"   
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,Ã�Ü 8.�� �£�£�£�£  RSS Feed �Ñ�:�Ñ�:�Ñ�:�Ñ�:  
  
1. EA��  Nature ���¬,Y  RSS/¢�% NJM7�Š 

http://www.nature.com/nature/newsfeeds.html 
2. 	È�Ð Nature ,Ã�*,Y T™8GT™8GT™8GT™8G RSS �Ó�Ü�Ó�Ü�Ó�Ü�Ó�Ü�"EÞ�¾ Copy 
Shortcut�x�â���À�L�Ž�ä�y�x�â���À�L�Ž�ä�y�x�â���À�L�Ž�ä�y�x�â���À�L�Ž�ä�y  �"  
3. �ý  RefWorks ���|EÞ�¾  “Search �|�|�|�|  RSS Feed” 
�"  
4. 	È�Ð�K�Û�À�L�Ž�ä2mC	7È  RSS Feed URL ��
���"   
5. &Ž�Ð  Add RSS Feed�x#Ð�u�x#Ð�u�x#Ð�u�x#Ð�u  RSS /¢�%/¢�%/¢�%/¢�%�y�y�y�y  �" . 
6. �}LÕ?V�³1)��	û���ä 	«�Ï Aº RSS/¢�%�"&Ž�Ð  OK .CAy.CAy.CAy.CAy �"  
7. �Û�(�Õ�Õ�ÿ��/�  RSS/¢�%4¨�q,Y�…0l	¸�"EÞ�¾  “All in 
List” �x�ì>=���=F½�¶�D�y�x�ì>=���=F½�¶�D�y�x�ì>=���=F½�¶�D�y�x�ì>=���=F½�¶�D�y  �|�K&Ž�Ð  “Import” �xEh�:�y�xEh�:�y�xEh�:�y�xEh�:�y  �ÞJƒ
�Û���Þ �¶�D#Ð�u7È�},YBû���"	—5Ø�\)��Û��/��ý  “Last 
Imported Folder” �x�ÕE¦�Ñ�:�\�Ë���y���" �
 
 
 
 
 
 
 
 
 
 
,Ã�Ü 9.�� �•�ºG¢�â�•�ºG¢�â�•�ºG¢�â�•�ºG¢�â ,YA…�*,YA…�*,YA…�*,YA…�* 
 
1. �ý  RefWorks ���|EÞ�¾  View=> �|�|�|�|  Duplicates=>�x�y�x�y�x�y�x�y  

Exact  Match,�º,à2“.C	�G"�º,à2“.C	�G"�º,à2“.C	�G"�º,à2“.C	�G" ,Y,Y,Y,YG¢�âG¢�âG¢�âG¢�âA…�*A…�*A…�*A…�* �"�"�"�"    
2. RefWorks �Û�Î�E�C�h�����Þ A…�*,Y�15Ú�!Nm	â
a�Ï
(��I�Ò�,!ŠE°>!!©EX�|'�	ã�¥�p �a�=	�G",YG¢�âA…�* �"  
3. RefWorks �Û�ÕE¦#Ð�u,Y“G¢�âA…�*” �Ü�Ï�p �}�õL9�"
"½�ä�Š   �W�q�-�ý�Þ�6�ë�º�ß,Y,Í	áA…�*�|!¤NNG¢�â�š�Ü
�Ï�Õ�6A…�*�p�õL9�"�}LÕ?V� �º�ÜA…�K�« G¢�â,YA…�*E°
>!�õL9�"  
4. �ÜA…�ÜA…�ÜA…�ÜA… ���ÞLÕ?V�õL9,Y �K�« A…�*�" 
5. &Ž�Ð “Delete” �ÞJƒ�ÛA…�*�£Bû����#ÚL9�"   
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,Ã�Ü,Ã�Ü,Ã�Ü,Ã�Ü 10.�������� �T*ý�T*ý�T*ý�T*ý  Output Style Preview Utility�xEh�xEh�xEh�xEh

�Ï���äNY?•�º�L�y�Ï���äNY?•�º�L�y�Ï���äNY?•�º�L�y�Ï���äNY?•�º�L�y  
 
1. �£�º�L�ä��EÞ�¾  Tools=> Preview Output 

Style�|�|�|�|Eh�Ï���äNY?•Eh�Ï���äNY?•Eh�Ï���äNY?•Eh�Ï���äNY?•  �"   
2. �£  Preview�xNY?•�y�xNY?•�y�xNY?•�y�xNY?•�y �à�ž9±	*���|EÞ�¾  AMA 
- American Medical Association 9th Edition�"  
3. T­Ay�š�Š�à�|  “Use References from your 
account”�x�T*ý�x�T*ý�x�T*ý�x�T*ý �},YBû	Ì��,Y�},YBû	Ì��,Y�},YBû	Ì��,Y�},YBû	Ì��,Y 	—5Ø�\)��y	—5Ø�\)��y	—5Ø�\)��y	—5Ø�\)��y  >€EÞ
���"�WLÕ�É�a�I
���/� �â	á 	—5Ø�\)�2P
` ,YEh�Ï
���ä�| &Ž�ÐAºEÞNN�"M7�Ž����,Y�Î�Ó	Ì 	«#]	«#]	«#]	«#] �"  
4. E©�³ Preview�à�ž9±	*�à�ž9±	*�à�ž9±	*�à�ž9±	* �|�KEÞ�¾  Chicago 15th 
Edition (Notes & Bibliography)�º,àAº���ä�Û�W�*��
/�	Ù/¢	—5Ø�\)� 2P
`,Y�;,Ã�!�\�Z�ê*ý
a6ï"½���ä
�"  
 
 
 
 
 
,Ã�Ü 11.�� 7����º�1�x�õ4´�Ž"ª�y7����º�1�x�õ4´�Ž"ª�y7����º�1�x�õ4´�Ž"ª�y7����º�1�x�õ4´�Ž"ª�y  
 
"½�ä�Š"½�ä�Š"½�ä�Š"½�ä�Š   1�  1-5 NN?V"��}�ý4”�K,P�*�},Y  RefWorks Bû���"  
 
1. �£�º�L�äEÞ�¾  References=�(�(�(�( Export �|�|�|�|

�Ñ�Ï	—5Ø�\)��Ñ�Ï	—5Ø�\)��Ñ�Ï	—5Ø�\)��Ñ�Ï	—5Ø�\)�  �"   
2. �£�à�ž9±	*��EÞ�¾	—5Ø�\)��\�Ë���"  
3. EÞ�¾ Citation List �x�ê�\�ì>=�y�x�ê�\�ì>=�y�x�ê�\�ì>=�y�x�ê�\�ì>=�y  �1�� EhEhEhEh
�Ï���ä�Ï���ä�Ï���ä�Ï���ä  �"  
4. &Ž�Ð Export to Text File�|�|�|�|Eh�Ï7È�\���\Eh�Ï7È�\���\Eh�Ï7È�\���\Eh�Ï7È�\���\
�Ë�Ë�Ë�Ë�"  
5. �Õ�ÿ�…,Y0l	¸�Û�(�Õ�|�¥/��Û�\�Ë�²�-7ÈAv
1l���"�x��4˜�5���|�}�âLÕ�²�-Aº�\�Ë�|	¿��
�²�ÖAº0l	¸�(�Õ	H	Ä�y�"  
6. 
��}�\�,�Ù)ÛED�Ë�|'�	ãEh�: “This is my 
paper on Influenza” �"  
7. EïEœEh�:�»�Û�Á	Ì “ {{ ” �§�:�	�Ë�ê�\	5�"0û
�x�â*ý#Ð�u�ê	Ì�y�"   
8. E©�³��/�,Y�ê�\�ì>=�|'�	ã�£�ì>=���â��  
Ref ID�|�K�ý�»�Û�Á	Ì	ã �§�:�ë2mC	�§�:�ë2mC	�§�:�ë2mC	�§�:�ë2mC	 Aº4ë	Ì�"  
9. Eh�:Aº4ë	Ì	ã�| #Ð�u�Õ�ÿ�Û	Ì#Ð�u�Õ�ÿ�Û	Ì#Ð�u�Õ�ÿ�Û	Ì#Ð�u�Õ�ÿ�Û	Ì �"    
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10. �Õ	ãE©�³�ê�\�|�K �â���â���â���â�� 	»�Õ�ÿ	»�Õ�ÿ	»�Õ�ÿ	»�Õ�ÿ  RefID �K�Û�K2ü�z�Û	Ì2mC	7È�},Y�\�Ë�"  
11. �T*ý	È�Û�Á	Ì “ }} ” �HKÂ�	�Ë�ê�\	5�"0û�x�â*ý#Ð�u�ê	Ì�y�"  
12. Save�x�²�-�y�x�²�-�y�x�²�-�y�x�²�-�y  �\�8�"  
13. �ý  RefWorks �� �| �£ �º �L �ä EÞ �¾  
Bibliography �x�;,Ã�y�x�;,Ã�y�x�;,Ã�y�x�;,Ã�y  �"  
14. �£�à�ž9±	*��EÞ�¾�Ð�*Eh�Ï���ä�"   
15. EÞ�¾ Format Paper and Bibliography
�x���ä�ëA•�\
a�;,Ã�y�x���ä�ëA•�\
a�;,Ã�y�x���ä�ëA•�\
a�;,Ã�y�x���ä�ëA•�\
a�;,Ã�y  �"�"�"�"  
16. #$?•7È Document to Format�x�Z���ä�x�Z���ä�x�Z���ä�x�Z���ä
�ë,Y�\�Ë�y�ë,Y�\�Ë�y�ë,Y�\�Ë�y�ë,Y�\�Ë�y  �"�"�"�"  
17. &Ž�Ð Create Bibliography�x�ð�Ï�;,Ã�x�ð�Ï�;,Ã�x�ð�Ï�;,Ã�x�ð�Ï�;,Ã
�y�y�y�y  �"�"�"�"  
18. �Û��/��û�Þ !8.C,Y �ê�\
a���ä�ë�;,Ã,Y
1��a�Ò �\�Ë�"�}	Ä�ÛAº�\�Ë�²�-7ÈAv1l
���"  
 
 
 
 
 
 
 
 
 
,Ã�Ü 12.�� �T*ý�T*ý�T*ý�T*ý  Windows (�(�(�(�  Write-N-Cite III 7����º�1�x	ÄEÞ�y7����º�1�x	ÄEÞ�y7����º�1�x	ÄEÞ�y7����º�1�x	ÄEÞ�y  
 
"½�ä�Š"½�ä�Š"½�ä�Š"½�ä�Š��4˜�5?V"��àER�K�^>š  Windows (�  Write-N-Cite III�"  
 
1. ,P�Ï  RefWorks�"   
2. �(�Õ  Microsoft Word  �KEïEœ Word �º
�L�ä�ë�!M7�Ó>=
��}  Write-N-Cite  III �"  
3. ,P�*�},Y  RefWorks �E�C�h�"  
4. EÞ�¾ Always on top�x� 4•�Õ�"�y�x� 4•�Õ�"�y�x� 4•�Õ�"�y�x� 4•�Õ�"�y �²�Ö  
Write-N-Cite Ld�Ë	Ä?–�"  
5. EÞ�¾ Tools=�(�(�(�(  Create/Update Offline 
Databases�|�KEÞ�¾���|�KEÞ�¾���|�KEÞ�¾���|�KEÞ�¾�� Create���<>!7������<>!7������<>!7������<>!7���
�ð�Ï	—5Ø�\)��ð�Ï	—5Ø�\)��ð�Ï	—5Ø�\)��ð�Ï	—5Ø�\)� �y�y�y�y  
6. �àER�a�å�|&Ž�Ð  Work Offline �x7����x7����x7����x7���
�º�1�y�º�1�y�º�1�y�º�1�y  EÞNN�" 
7. �ý�},Y�\�8���|Eh�:�º�à�\�,�Š   
8. �£  View =>Folder�x�º,à�\�Ë���y�x�º,à�\�Ë���y�x�º,à�\�Ë���y�x�º,à�\�Ë���y  9±	*EÞNN��EÞ
�¾	—5Ø�\)��\�Ë�� �"�"�"�"  
9. �ý  Word �\�8���ÛTõ�Ü��5C�ý �}�È?V�§�:�ê�\,Y�}�È?V�§�:�ê�\,Y�}�È?V�§�:�ê�\,Y�}�È?V�§�:�ê�\,Y

��Ž�"
��Ž�"
��Ž�"
��Ž�"   
10. E©�³ Write-N-Cite III�|&Ž�Ð �¥�6 A…�*�–EŽ,Y Cite 
JÓ�z�ê*ýAºA…�*�"  

Write n Cite Window 
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11. �Û�\�8�²�-��  WNCOffline �"  
12. E©�³ Write-N-Cite 0l	¸0l	¸0l	¸0l	¸ �|&Ž�Ð  Bibliography�x�x�x�x
�;,Ã�y�;,Ã�y�;,Ã�y�;,Ã�y  �KEÞ�¾A•�\,YEh�Ï���ä�"&Ž�Ð  Create 
Bibliography �x�ð�Ï�;,Ã�y�x�ð�Ï�;,Ã�y�x�ð�Ï�;,Ã�y�x�ð�Ï�;,Ã�y  �ÞJƒ�"  
13. �},Y�\�8�ÛE°>!���ä�ë�" �²�-�\�8 �x�x�x�x File �|�|�|�|  
Save �y�"�y�"�y�"�y�"  
14. E©�³���ä�ë	ã,Y�\�8�K4¼4ÂEh�:�\�,�K#Ð�u�Õ
�p�…,Y�ê�\�"�}	Ä�º�ï ö#Ð�u	á�Õ2P�x/Å���ï�:$e
�ê*ý�y,Y�ê�\	5�"0û  
15. EïEœ�£ Write-N-Cite III ,Y Bibliography�x�;,Ã�y  
	�
´EÞ�¾�â	áEh�Ï���ä�|G¢�âE°>!�;,Ã�ð�Ï�"�},Y
�\�8�Û �º�…,Y���äE°>!���ä�ë�"�²�-�\�8�x File�|
Save�y�"    
 
 
,Ã�Ü 13.�� �Ü�Ò
a�7�âBû	Ì�Ü�Ò
a�7�âBû	Ì�Ü�Ò
a�7�âBû	Ì�Ü�Ò
a�7�âBû	Ì  
 
1. EÞ�¾ Tools=>Backup/Restore�"�"�"�"    
2. �ýT­Ay (‹�Ö�à�| ���Þ�Ü�ÒEÞNN>€EÞ���"&Ž�Ð  
Perform Backup �ÞJƒ�<>!�<>!�<>!�<>! �Ü�Ò�Ü�Ò�Ü�Ò�Ü�Ò�"  
3. �Û�¥/��}�²�-  .rwb �ë  .zip �\�Ë7ÈAv1l���" �²�-Aº�²�-Aº�²�-Aº�²�-Aº
�\�Ë�\�Ë�\�Ë�\�Ë 7È�!M77È�!M77È�!M77È�!M7�|�º�Ž�” 	ãM7�T*ý�"   
4. �WLÕ�7�â�|EÞ�¾ Tools, Backup/Restore �"  
5. &Ž�Ð Restore�ÞJƒ�"  
6. #$?•#$?•#$?•#$?•7È .rwb �ë  .zip �\�Ë�"  
7. �âEÞ Include References�x�Ú�Á	—5Ø�\)��x�Ú�Á	—5Ø�\)��x�Ú�Á	—5Ø�\)��x�Ú�Á	—5Ø�\)�
�y�y�y�y  �|�|�|�|  Include RSS Feeds�x�Ú�Á�x�Ú�Á�x�Ú�Á�x�Ú�Á  RSS Feed
�y�y�y�y  �º	Ÿ  Include Output Styles�x�Ú�ÁEh�Ï�x�Ú�ÁEh�Ï�x�Ú�ÁEh�Ï�x�Ú�ÁEh�Ï
���ä�y���ä�y���ä�y���ä�y  �x�Þ'<LÕ?V�:EÞ�¾�y�"    
8. &Ž�Ð Perform Restore�x�Õ� �7�â�y�x�Õ� �7�â�y�x�Õ� �7�â�y�x�Õ� �7�â�y  .  
9. �},YBû���Û>€�7�â  - ���Þ	—5Ø�\)��! Ref 
ID�!	—5Ø�\)��\�Ë��
a�o��EÞNNFÒ>€�7�â�"  
 
"½�ä�Š"½�ä�Š"½�ä�Š"½�ä�Š �7�â�E�C�h�ï�Ñ7ÉBû����,Y���Þ�¶�D>€?[,«�"�W�q�}�7�â	»�Õ�ÿ*ý��,Y�\�Ë�x*ý
�cEh�Ï���ä�F�€�y�|��&•�ÏAƒ�}	«#]EÞ�¾  Include References�x�Ú�Á	—5Ø�\)��y�x�Ú�Á	—5Ø�\)��y�x�Ú�Á	—5Ø�\)��y�x�Ú�Á	—5Ø�\)��y  
a  
Include RSS Feeds�x�Ú�Á�x�Ú�Á�x�Ú�Á�x�Ú�Á  RSS Feed�y�y�y�y  �"E®���/�ï�Ñ7É�E�C"
E±�÷���"  
 

���ä�ë	ã,Y�\�8  


